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About This Guide

This document describes known issues with the NetWare® 6.5 Public Beta. The issues are divided 
into sections based on product features.

Additional Documentation

For complete information on setting up and using the NetWare 6.5 Public Beta, see the NetWare 
6.5 Documentation Web site (http://www.novell.com/documentation/lg/nw65).

Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell® trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as UNIX*, should use forward slashes as required by your software.
About This Guide 7
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1 Overview

NetWare 6.5 is the most reliable services platform for delivering secure, non-stop access to 
network and information resources. It is engineered to deploy business critical, open source-
enabled services. With NetWare 6.5, Novell gives you choice and flexibility, creating greater 
application interoperability, delivering continuous availability, and empowering users with tools 
that deliver new levels of productivity.

For additional information about NetWare 6.5, see the NetWare Product Web site (http://
www.novell.com/products/netware).

NetWare 6.5 Public Beta Package

The Public Beta package includes the following:

NetWare 6.5 CD 1 (Operating System)

NetWare 6.5 CD 2 (Products)

Novell Nterprise Branch Office CD

Novell DirXML Starter Pack CD

NetWare 6.5 Demonstration Kit (Digital Airlines)

In addition, you will need the Novell Clients Software CD (March 2003), which is available as a 
download from the Novell Public Beta Web site (http://beta.novell.com/public.jsp). This CD 
includes the following:

Novell ClientTM 4.9 for Windows* NT*/2000/XP

Novell Client 3.4 for Windows 95/98

Novell Modular Authentication Service (NMASTM) Client 2.2

Client NICI 2.6 for Windows

NetIdentity Client

Novell NetDrive Client 4.1

Novell ConsoleOne® 1.3.6 with NetWare 6.5 snap-ins

exteNdTM WorkbenchTM 4.1

exteNd Client 5.0

To download the client software:

1 Access the Novell Public Beta Web site (http://beta.novell.com/public.jsp). 

2 Type your contact name and e-mail address, select BETA - NetWare 6.5, then click Go.

3 Select View Download/Updates, then click Go.

4 Locate the desired software, then click Download. 
Overview 9
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5 Follow the on-screen instructions. 

Public Beta Support

Novell doesn’t provide technical support for Public Beta products. However, we welcome your 
feedback about your experience with this release. To submit comments:

1 Access the Novell Public Beta Web site (http://beta.novell.com/public.jsp). 

2 Type your contact name and e-mail address, select BETA - NetWare 6.5, then click Go.

3 Select Report Problem, then click Go.

4 Enter your feedback, then click Continue.

NetWare 6.5 Documentation

For complete information on installing and using the NetWare 6.5 Public Beta software, see the 
NetWare 6.5 Documentation Web Site (http://www.novell.com/documentation/lg/nw65).
10   NetWare 6.5 Public Beta Readme
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2 Installation/Upgrade

For complete instructions on installing this Public Beta, see the NetWare 6.5 Overview and 
Installation Guide.

Conditions for Installing NetWare 6.5 Public Beta

The NetWare® 6.5 Public Beta installation is supported only under the following conditions:

Install only in an isolated, nonproduction test environment.

Install onto a clean, error-free disk drive.

Remove files from any previous installation, then run the scandisk or chkdsk DOS utilities to 
verify the integrity of the DOS partition.

Install a NetWare 6.5 Public Beta server into a tree that has versions of eDirectoryTM (NDS®) 
8 or later. 

Installing into a tree with a version earlier than eDirectory 8 can make User objects 
unmanageable when using management utilities other than those that ship with NetWare 6.5

Upgrade only from the following:

NetWare 5.1 server with Service Pack 6 and Novell eDirectory 8 version 8.85 or later

NetWare 6 server with Service Pack 3

Remote Install/Upgrade

After the initial reboot during a remote upgrade, a login screen might display requiring you to log 
in to the server being upgraded. If this occurs, provide the login information, click the Details 
button, type the IP address of the server being upgraded, then click OK.

If Install/Upgrade tasks fail to run from iManager, you might need to change your security settings.

1 In Internet Explorer, select Tools > Internet Options.

2 Click Security > Custom Level.

3 Click the Enable radio button under Initialize and Script ActiveX Controls Not Marked as 
Safe.

4 Click OK.

Installing with Adaptec ADPT160M

When installing with Adaptec* ADPT160M, you might receive an Abend Page Fault Processor 
Exception message after the drivers are selected. 

To avoid this, remove the PSM before the drivers are loaded. Then after the installation, add 
*.PSM to the startup.ncf file and copy the *.PSM driver manually to the c:\nwserver directory.
Installation/Upgrade 11
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WAN Boards Don’t Load during a NetWare 6.5 Upgrade

WAN boards don’t load after the server reboots following the initial file copy during an upgrade 
to NetWare 6.5. This is a problem if the server needs the WAN board loaded to complete the 
upgrade to NetWare 6.5. This occurs with all supported NetWare platforms using WAN boards.

To load the boards manually, enter reinitialize system at the server console. 

To automatically load the boards during the installation, add defupgrd.ils to the c:\nwupdate 
directory of the server being upgraded. Defupgrd.ils must contain the Reinitialize System 
command to load the WAN boards. Add the following text to defupgrd.ils:

@Fileset

 Description: "Default Upgrade Modules"

   Name:   DefUpgrade_Files

   Class:  MANDATORY

   Bytes:  0

   DiskBytes:  0

console ’Reinitialize System’, 2

@EndFileset

After the upgrade has completed and the server starts, the WAN boards load normally.

Known Problem with USB Hard Drives during NetWare 6.5 Install

On certain machines, a USB hard drive that is plugged into the machine during a new install might 
be detected as the primary boot driver on the system, so the Sys: volume will be created and 
installed on the USB device. This is not the intended or desired behavior for NetWare 6.5, and it 
will be fixed the final release. For this Public Beta release, unplug any USB storage devices from 
the machine before beginning the NetWare 6.5 installation. (USB keyboard and USB mouse are 
supported during install and should behave as expected.)

Interoperability with Other Novell Products

For a description of interoperabiity issues between this Beta release and other Novell products, see 
Chapter 3, “Interoperability Issues,” on page 13.
12   NetWare 6.5 Public Beta Readme
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3 Interoperability Issues

This section describes interoperability issues that exist between NetWare® 6.5 Public Beta and 
other Novell® products. 

Products Not Supported with This Beta

The following Novell products are not supported with this Beta release:

BorderManager® 3.7

ZENworks® for Desktops 3.2 Support Pack 2

ZENworks for Desktops 4 Support Pack 1

ZENworks for Servers 3 Support Pack 2

ZENworks OnDemand ServicesTM 2.0

GroupWise WebAccess Installation on NetWare 6.5

The default installation of GroupWise® WebAccess on a NetWare 6.5 Web server will result in 404 
Web browser errors when trying to log in to GroupWise WebAccess (http://server_address/servlet/
webacc) or GroupWise WebPublisher (http://server_address/servlet/webpub). 

To resolve this issue: 

1 Install GroupWise 6.5 WebAccess or GroupWise 6 SP3 WebAccess.

During the install, make sure you install the WebAccess Application and the WebPublisher 
Application (optional) to the Apache directory (sys:\apache2) and the Tomcat4 root directory 
(sys:\tomcat\4). The Tomcat path should be detected automatically. 

2 After the installation is complete, open the sys:\tomcat\4\webapps\root\web-inf\web.xml file.

The file contains <servlet> entries for WebAccess (webacc) and Novell Spell Checker 
(spellchk). If you installed WebPublisher, it also contains a WebPublisher <servlet> entry 
(webpub).

3 Locate the last </servlet> tag, then add the following servlet mapping information between 
the </servlet> tag and the </web-app> tag:

<servlet-mapping>
<servlet-name>webacc</servlet-name>
<url-pattern>/servlet/webacc</url-pattern>

</servlet-mapping>
<servlet-mapping>

<servlet-name>spellchk</servlet-name>
<url-pattern>/servlet/spellchk</url-pattern>

</servlet-mapping>

If WebPublisher is installed, also add the following information to the same location:
Interoperability Issues 13
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<servlet-mapping>
<servlet-name>webpub</servlet-name>
<url-pattern>/servlet/webpub</url-pattern>

</servlet-mapping>

4 Save and exit the web.xml file.

5 Stop and restart Tomcat4 (or restart the server).

6 Make sure the GroupWise WebAccess Agent, Message Transfer Agents, and Post Office 
Agents are running.

7 Log in to GroupWise WebAccess to verify that WebAccess is functioning properly.

NetWare 6.5 Upgrade after GroupWise WebAccess Installation

When you upgrade to NetWare 6.5 on a server where GroupWise WebAccess is installed, the 
NetWare 6.5 installation program updates the WebAccess configuration files (webacc.cfg, 
spellchk.cfg, and webpub.cfg in the novell\webaccess directory on the root of the Web server). It 
changes references to Tomcat 3.3 to Tomcat 4. 

For example, it changes references to the Tomcat\33 directory to the Tomcat\4 directory. However, 
it does not make changes to the WebAccess objects in the eDirectory tree because there is no 
convenient way to determine where the WebAccess objects are located in the tree.Therefore, you 
must manually change the Tomcat version information on the WebAccess objects. 
IMPORTANT: If you do not manually update the Tomcat information on the WebAccess objects and you 
subsequently edit the WebAccess configuration information in ConsoleOne, ConsoleOne will overwrite the 
configuration files that were updated by the NetWare 6.5 installation program with obsolete Tomcat information 
and WebAccess will stop working.

1 In ConsoleOne, browse to and right-click the WebAccess Application object 
(GroupWiseWebAccess), then click Properties.

2 Click Application > Templates.

3 In the Template Path field, change Tomcat\33 to Tomcat\4, then click OK.

4 Right-click the Speller Application object (NovellSpeller), then click Properties.

5 Click Application > Environment.

6 In the Template Path field, change Tomcat\33 to Tomcat\4, then click OK.

7 If you have installed WebPublisher, right-click the WebPublisher Application object 
(GroupWiseWebPublisher), then click Properties. 

8 Click Application > Templates.

9 In the Template Path field, change Tomcat\33 to Tomcat\4, then click OK.
14   NetWare 6.5 Public Beta Readme
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4 Apache Web Server on NetWare

Remote Upgrades

If, during a remote upgrade, you accept the defaults for the LDAP server (specifically, Require 
TLS for Simple Binds), the Apache2 Admin Server will not get completely configured.

There are three ways to solve this issue:

1. Uncheck the Require TLS for Simple Binds check box during installation.

2. Give administrative rights to additional users by adding their User objects to the apchadmn-
Administrators group.

3. Run a local post-install of the Apache2 Admin Server from the server GUI; the configuration 
issues will be fixed automatically.
Apache Web Server on NetWare 15
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5 ConsoleOne 1.3.6

Using ConsoleOne to Manage NetWare 4 Servers

In order to use ConsoleOne® to manage a tree containing NetWare® 4 servers (DS v 6.17), IPXTM 
must be installed on the management client. Even if ConsoleOne is run from a NetWare box via a 
mapped drive on the client, the client machine that ConsoleOne is running on must be able to 
connect natively via IPX.

Using the -forceMaster Switch

Using the -forceMaster switch when starting ConsoleOne will cause ConsoleOne to always talk to 
the master replica for the objects being accessed.

We don't recommend using this switch during normal use of ConsoleOne. Use this switch only 
under direction from Novell Technical ServicesSM personnel.

ConsoleOne Installation during a Remote Upgrade

ConsoleOne 1.3.6 might fail to install on the server during a remote upgrade using nwdeploy.exe. 
If this happens, use any of the post-install methods to install ConsoleOne on the server.
ConsoleOne 1.3.6 17
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6 DirXML Starter Pack

For DirXML® setup information, refer to the DirXML Starter Pack Deployment Guide (http://
www.novell.com/documentation/beta/dirxmldrivers/index.html?page=/documentation/beta/
dirxmldrivers/jetset/data/front.html).

Activation

Activation features have been disabled for this Public Beta release. 
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7 DNS/DHCP

For Improved Performance

For improved management tool performance, configure the DNS/DHCP scope settings before 
you start using the Novell® iManager DNS/DHCP management utility and the Java*-based 
Management Console. 

The recommended settings for the Novell iManager DNS/DHCP management utility are as 
follows:

Subnet Address Range References to External DHCP Server

While importing the DHCP configuration, if the subnet address range contains a reference to an 
external DHCP server, this reference is automatically replaced by a reference to the default DHCP 
server that you specify.

Operating Conditions

For best results, ensure that 

All zones serviced by the Novell DNS servers have the designated primary or secondary value 
assigned.

Every secondary zone has its master server IP address value assigned.

You do not have an RRset that contains both CNAME and other records.

If these conditions aren’t met, the server will exit and a corresponding error message will be logged 
in sys:\named.run.

ISC Versions

The Novell DNS and DHCP servers are based on ISC BIND Version 9.2.0 and ISC DHCP Version 
2.

Display Settings Font Size Browser Text Size

800×600 Small Medium to Smallest

1024×768 Small Largest to Smallest
DNS/DHCP 21
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8 eGuide 2.1.1

For Novell® eGuideTM 2.1.1 information, refer to the Readme (http://www.novell.com/
documentation/beta/eguide211/readme/eguide_readme.html) located in the Novell eGuide 2.1.1 
online documentation (http://www.novell.com/documentation/beta/eguide211/index.html).
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9 exteNd Application Server

For complete information on using the exteNdTM Application Server, see the online help included 
with the software or see the exteNd Application Server 5.0 online documentation (http://
www.novell.com/documentation/lg/extendas50).

Don't Use SilverCmd through Apache Port

Using SilverCmd through the Apache WSI is not reliable and might cause a server fault. All 
SilverCmd and SMC usage should go directly to the application server’s port (the default is 83).

Limitation on Upgrades from NetWare 6.0

Upgrading from NetWare® 6.0 is not recommended; the JMS feature (jBroker MQ) won’t work in 
this scenario.

Limitation on Upgrades from NetWare 5.1

Upgrading from NetWare 5.1 won’t succeed because of problems installing MySQL (which is 
required by the application server). In this scenario, MySQL is installed to the traditional file 
system volume sys:, but it works only on an NSS volume. As a result, both MySQL and the 
application server fail.

Running with Multibyte Code Pages

The MySQL JDBC driver included with NetWare 6.5 (Connector/J 3.0.6) does not work on 
multibyte code pages (for example, Japanese). This affects the application server, which uses 
MySQL for its SilverMaster database. 

If you have a multibyte code page on your server, you need to download a newer driver 
(Connector/J 3.0.7):

1 Access the Novell Public Beta Web site (http://beta.novell.com/public.jsp).

2 Type your contact name and e-mail address, select BETA - NetWare 6.5, then click Go.

3 Select View Download/Updates, then click Go.

4 Locate the mysqldriver.zip file, then click Download.

5 Unzip the download.

The zip file contains the new JAR file: mysql-connector-java-3.0.7-stable-bin.jar.

6 Before replacing the old JAR file with the new one, type java -exit.

7 Replace your sys:\java\lib\ext\mysql-connector-java-3.0.6-stable-bin.jar file with the new 
mysql-connector-java-3.0.7-stable-bin.jar file.

8 Restart java.

9 Create the SilverMaster database by running
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sys:\extend\appserver\bin\silverinit appserver_password admin_password 
mysqlroot_password

where the default passwords are appserver, admin, and [no password].

10 Run silverserver to start the application server.

TCP/IP Configuration Requirements for jBroker on Windows (Affects Pet Store)

If you encounter a JMS initialization problem when running the setup for the Pet Store sample 
application, you might need to adjust your TCP/IP configuration. The Pet Store setup uses jBroker 
tools, which require your Windows machine to append the server’s DNS domain to the server 
name (even if you’re using the server's IP address). To meet this requirement, change the Windows 
machine's network properties for the TCP/IP protocol to specify the appropriate domain in your 
DNS settings.
26   NetWare 6.5 Public Beta Readme
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10 exteNd Workbench

For complete information on using exteNdTM WorkbenchTM, see the online help available with the 
software or see the exteNd Workbench 4.1.1 online documentation (http://www.novell.com/
documentation/lg/workbench411/index.html).
exteNd Workbench 27
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11 iManager 2.0

For Novell® iManager 2.0 information, refer to the Readme (http://www.novell.com/
documentation/beta/imanager20/readme/imanager_readme.html) included in the Novell 
iManager 2.0 online documentation (http://www.novell.com/documentation/beta/imanager20/
index.html).
iManager 2.0 29
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12 IP Address Management 

Command Length

Entering a command over 200 characters long at the server console will result in an abend.

Begin Refresh

A continuous series of clicks of the Begin Refresh button occasionally does not work and results 
in the Ipmcfg.nlm: Internal HTTP Server error: Invalid handle error.

Uninitializing httpstk.nlm

When httpstk.nlm is unloaded at the server console, ipmcfg.nlm is not uninitialized.

Debugging Messages

Some unwanted debugging messages might on the system console screen. 

Manual Update of sys:etc\hosts File

If you change an IP address from the server’s autoexec.ncf file, you will need to manually update 
the sys:etc\hosts file. Currently this file is updated if the following procedure is performed (this 
can be done using NetWare® Remote Manager (NRM) or INETCFG, the server-based utility):

Using NRM

1 Log in to NRM and then click Configure Internetworking > Start TCP/IP Configuration > 
TCP/IP to interface Bindings > an_existing_binding.

 The Binding TCP/IP to Board_name Interface with IP Address IP_Address window displays.

2 In Local IP Address, type the IP address that you want to change to, then click Save.   

3 Click IP Address Management in the left pane. 

The IP Address Management page displays.

4 Ensure that all the applications are in Valid status.

5 Click Restart Server.

NOTE: This button appears on the IP Address Management page only after a change is made.

Using INETCFG

1 Change the IP address. 

2 Enter reinitialize system at the server console and reboot the server.

If the etc\hosts file is out of sync with the current IP address, the file will not be updated 
automatically when the IP address changes, and you will have to update the file manually.
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Manual Update of sys:etc\hostname File

Any change in the IP address of the server requires a manual update of the sys:etc\hostname file.
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13 iPrint

Secure Printing on a Terminal Server Not Supported

Printing from a terminal server using secure printing (SSL) is not supported.

User Printers Cannot Print a Test Page 

Users who have installed user printers cannot print a test page.
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14 MySQL for NetWare

Username and Password When Using phpMyAdmin

When you access phpMyAdmin from the Web Manager home page (on port 2200), you are 
prompted for a username and password. The username and password being requested are your 
MySQL* username and password. By default, the username is root and there is no password.

Legal Issues

For important legal issues related to your use of MySQL 4.0, refer to the sys:\mysql\license.doc 
file after installation.

Using MySQL 4.0.12 with NetWare 6.5 Public Beta

Because NetWare® 6.5 has a newer LibC, do not use MySQL 4.0.12 with this Beta.

Using a Nondefault Data Directory

If you install MySQL and configure it to use a nondefault data directory that is more than one-level 
deep, the default database will not be created.

To resolve this issue, create the data directory as specified during the installation and in 
sys:\etc\my.cnf and run mysql_install_db at the NetWare system console.

Novell exteNd and Non-default Data Directories

If you install MySQL and Novell® eXtendTM with a nondefault data directory, MySQL will not 
start. 

To resolve this issue, remove the following three lines from the sys:\etc\my.cnf file:

innodb_data_home_dir=SYS:\mysql\data\

innodb_log_group_home_dir=SYS:\mysql\data\

innodb_log_arch_dir=SYS:\mysql\data\

Accessing the Official MySQL Documentation

To access the official MySQL documentation, visit http://www.mysql.com/doc (http://
www.mysql.com/doc).
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15 NetWare FTP Server

Data Transfer Issues

In this Beta, operations such as get, put, ls, and dir from multiple FTP sessions for more than 
10,000 files in a directory might fail. This will be resolved in the FCS release.

Security Extensions

Unloading FTP Server might take some time, after an SSL error occurs on a secure FTP client 
while establishing an explicit secure connection with FTP Server.

Using iManager for Configuration

When you administer NetWare® FTP server using iManager, the configuration information is 
read from and updated only to the sys:\etc\ftpserv.cfg file, which is the default configuration 
file for NetWare FTP Server. Therefore, make sure that sys:\etc\ftpserv.cfg is set as the 
configuration file.

When you set intruder detection parameters in the Security tab, if you set a value with 0 as 
one of the digits, the UI disables intruder detection (intruder detection parameters are greyed). 
This will be resolved in the FCS release.

Localization Issues

The FTP administration page is not available when the browser is set to some languages.

Saving parameter values containing Japanese characters is not supported.

When using FTP Server on a Japanese language machine, users might not be placed in their 
home directories. You can resolve this by including forward slashes (/) as path separators for 
home directories.

If you create a file or directory in a DOS namespace on a server with double-byte characters, 
the file or directory is created on that server with the name specified. However, the message 
to the FTP client might contain a different file or directory name. This happens in particular 
with the 0x8374 character in Shift_JIS, 30D5 in Unicode*, which is converted to 0x8354 in 
Shift_JIS, 30B5 in Unicode.
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16 NetWare iSCSI 

Known Issues

For this beta, AUTH_NONE is the only authorization method supported. This means that 
there is no authentication mechanism available between initiators and targets.

After executing the List Devices command at the server console, there might be a delay before 
the device list is displayed.

Occasional slow performance or dropped iSCSI connection problems might occur with 
certain router, switch, and hub configurations.

These network configurations might require that SACK (Selective ACK) be turned off for the 
TCP/IP stack running on the initiator. You can do this at the NetWare server console by 
entering:

set tcp sack option=off
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17 NetWare Migration Wizard 6.5

For additional issues related to NetWare® Migration Wizard, see the Readme posted on the   
NetWare Migration Wizard documentation Web site (http://www.novell.com/documentation/beta/
migwiz65/readme.txt).

Post-Install of Products after a Migration to NetWare 6.5

After completing the four steps of the migration using the NetWare Migration Wizard, ensure a 
post-install of Novell’s Web Products completes correctly:

1 Delete the following files:

sys:system\rootcert.der

sys:\adminsrv\.keystore

sys:adminsrv\adminserv.conf

sys:adminsrv\webapps\welcome\web-inf\classes\startup.properties

sys:adminsrv\webapps\apacheadmin\web-inf\classes\startup.properties

2 Proceed with a post-install of products, making sure to install Certificate Server, Apache 
Admin Server, and Tomcat.

3 (Conditional) If using the Deployment Manager to do a remote post-install, copy the 
sys:sys.mig\public\rootcert.der or sys:sys.mig\system\rootcert.der file to sys:system before 
post-installing any products.

The remote post-install currently does not re-create the rootcert.der file on the server. 
Rootcert.der is needed for some of the products to install and configure properly.

Performing Multiple NetWare 3-to-NetWare 6.5 Migrations

After successfully migrating a NetWare 3 server to a NetWare 6.5 destination server, if you 
attempt to migrate another NetWare 3 server to the same NetWare 6.5 destination server, or if you 
migrate the same NetWare 3 server to the same NetWare 6.5 destination server again, you will 
receive two error messages:

map3xids.nlm did not load properly

map3xids.nlm still running on the destination server

These errors occur because map3xids.nlm needs to unload on the destination server for the second 
migration to be successful. However, before map3xids.nlm can unload, tsafs.nlm must be 
unloaded on the destination server. Because the Migration Wizard is unable to unload tsafs.nlm 
automatically, map3xids.nlm never unloads. 

To avoid these errors, enter the following at the destination server console after successfully 
completing the first NetWare 3 to NetWare 6.5 migration:

unload tsafs.nlm
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unload map3xids.nlm

load tsafs.nlm

You will now be able to perform the second migration. If you intend to perform a third or fourth 
NetWare 3 migration to the same NetWare 6.5 destination server, enter these commands prior to 
each migration.
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Suspect Server Health

Because of the Beta license, the status (traffic light) for Server Health will be yellow (Suspect). 
Removing Licensing Information from the items that the server tracks for health status can remedy 
this situation. 

To change the health status:

1 Click Health Monitor.

2 In the Include column, uncheck the Licensing Information check box.

3 Click Apply.

HTTPSTK Port Configuration

In this Public Beta, if you want to change the port configuration for the httpstk.nlm file, use the 
port configuration feature on the IP Address Management page. You can access this page by 
clicking the IP Address Management link in the Navigation frame. 

Known Limitations in Multi-Server Volume Inventory

In this Public Beta, there is a known limitation in the Use Group Operations: Under NRM Server 
Reports, the Multi-Server Storage Inventory (the Compare Server Storage link) does not display 
the correct inventory statistics for the servers beyond the first one in the group. This will be fixed 
in the final release of NetWare 6.5.
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19 NetWare Web Search Server

Installing Web Search over a Previously Installed Version

If you install Web Search over a previously installed version that exists on any other volume 
besides the default sys: volume, the current NetWare® 6.5 installation of Web Search might not 
detect it. If not, it will install a second copy into the sys:\NSearch default directory.

Web Search Synchronization

When setting up a Web Search Synchronization cluster, set the Require Admin Authorization 
When Receiving Cluster Data setting to No.

Also, enter the individual Cluster Server URLs using the HTTP protocol, not HTTPS.

Rights-Based Searches

After you log in from the search form to perform a rights-based search, the navigation links on the 
results page (Prev, Next, Sort by, Print, Result List Format, etc.) do not work. This is because they 
are using the nonsecure HTTP port (80) instead of the secure HTTPS port (443).

To resolve this issue, go to the Security Settings page of your virtual search server and set Require 
HTTPS to No.
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20 Novell Advanced Audit Service (NAAS)

Novell® Advanced Audit Service is not included with NetWare® 6.5 Public Beta. New auditing 
capabilities will be available with the FCS release.
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21 Novell Certificate Server

Browser Support

You must use Internet Explorer 5 or later or Netscape Navigator 4 or later to use the certificates 
generated by Novell® Certificate ServerTM for SSL or LDAP connections. Older browsers are not 
supported.

Removing a Server from eDirectory

When removing a server from Novell eDirectoryTM and then reinstalling it into the same context 
with the same name, a successful reinstallation occurs only if the SAS Service object representing 
the removed server is also deleted, if it existed.

For example, for a server named MYSERVER, a SAS object named SAS Service–MYSERVER 
could exist in the same container as the server. This SAS object must be manually deleted (using 
ConsoleOne®) after the server is removed from the tree, but before the server is reinstalled into the 
tree.
IMPORTANT: If the server is the Organizational CA or the SD Key server, you must complete some additional 
steps. These steps are documented in TID 10056795 (entitled Certificate Server Issues: Removing a Server 
from a Tree). You can search for this TID in the Novell Knowledgebase (http://support.novell.com).

Extractable Key Support

When creating the Organizational CA object or Server Certificate objects (also known as KMOs), 
extractable keys are supported only if the server you selected for the key pair generation is running 
eDirectory 8.6 or later on NetWare and Windows NT platforms, or if it is running eDirectory 8.7 
or later on UNIX platforms. If you are attempting to make the keys extractable on an unsupported 
platform, you will receive a -1222 error.

Importing CRL Data onto CRL Object

Importing CRL data onto a CRL object is not supported through Novell iManager. You must use 
ConsoleOne for this feature.

Certificate Export Does Not Work through iManager 2.0 for This Release

In this public Beta, it is not possible to export certificates through iManager 2.0.This will be fixed 
in future releases. Currently, certificates can be exported using ConsoleOne or iManager 1.5.x. If 
you are trying to get the trusted root certificate for use in client code, you can map a drive to 
sys:\system and use rootcert.der.
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22 Novell Client for Windows

See the Novell® ClientTM Readme (http://www.novell.com/documentation/beta/noclienu/
index.html) for issues related to the Novell Client for Windows 95/98 and Novell Client for 
Windows NT/2000/XP.
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Cluster Pre-upgrade Not Required in Certain Scenarios

The Cluster Pre-upgrade option in the Deployment Manager is not required if you are upgrading 
from NetWare 6 to NetWare 6.5. It is only required if upgrading cluster servers from NetWare 5.1 
to NetWare 6.5.

Perform the Cluster Pre-upgrade from an Window NT/2000/XP Workstation

To prepare your cluster for an upgrade, you must run the Deployment Manager option from a 
Windows NT/2000/XP workstation rather than from a Windows 9x workstation.

Also ensure that your cluster-enabled volumes are in the Running state. Use the Cluster View in 
ConsoleOne® to check the state of each corresponding cluster volume resource.

Do Not Create Traditional Volumes during a Cluster Upgrade

Do not create new traditional volumes on NetWare 5.1 servers when upgrading a cluster from 
NetWare 5.1 to NetWare 6.5.

After one NetWare 5.1 server in the cluster is upgraded to NetWare 6.5, upgraded NSS volumes 
on shared storage might appear as free space in a traditional partition. Creating a volume on the 
free space will corrupt the NSS volume.

NSS volume corruption occurs if all of the following conditions exist on your system:

The Prepare a Novell Cluster for Upgrade option in the Deployment Manager was run and 
completed.

At least one of the NetWare 5.1 servers in the cluster was upgraded to NetWare 6.5.

One of the NetWare 5.1 servers not yet upgraded was rebooted and an attempt was made on 
that server to create a traditional partition using NWCONFIG.

Mirrored Partition Upgrades Not Supported

Upgrading mirrored partitions in a cluster is not supported for this Beta release. Upgrading 
mirrored partitions in a cluster from NetWare 6 to NetWare 6.5 will be supported for the NetWare 
6.5 final release.

Unable to Authenticate to a New Node during Installation

When you are installing a new node into a cluster, you might not be able to authenticate to the new 
node. If this happens, map a drive from the workstation running Novell ClientTM software to each 
node in the cluster and then repeat the steps to install the node into the cluster.
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Directory Tree Not Visible during Installation

When running the Cluster Services installation, you occasionally might be unable to see the 
Novell® eDirectoryTM tree you want to install into from the installation browser. If this happens, 
type the name of the tree in the browser path: treename/cluster.context.

Cluster Node Fails to Auto-Start after Installation

If Cluster Services (clstrlib.nlm) does not automatically start on a node immediately after 
installation, start it manually by entering the ldncs command at the server console.

Upgrade Does Not Upgrade Licenses

If you upgrade your cluster, you must manually apply new licenses for any additional nodes in 
your cluster beyond the first two nodes.

Some Cluster Resource Configuration Documentation Not Updated

Some of the documentation for configuring cluster resources has not yet been updated for this Beta 
release. It will be updated for the NetWare 6.5 final release.

Move LDNCS Command in Autoexec.ncf File

During the Novell Cluster Services installation an LDNCS command is automatically added to the 
end of the AUTOEXEC.NCF file of each cluster server. This command must be moved above the 
ADMSRVUP command in order to prevent the APACHE2.NLM module from causing a server 
abend. 

Prevent the AUTOEXEC.NCF file from running by starting each cluster server with the -NA 
command switch (server -na). Then edit the AUTOEXEC.NCF file of each server in the cluster 
and move the LDNCS command above the ADMSRVUP command.

This issue will be resolved for the final NetWare 6.5 release.
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Exiting DSDiag after Upgrading to NetWare 6.5 Public Beta

Exiting from DSDiag.nlm after upgrading to this Public Beta version of NetWare 6.5 causes 
multiple abends, system halts, and server restarts. This issue will be fixed in the shipping version 
of NetWare 6.5.

For additional Novell® eDirectoryTM 8.7.1 for NetWare information, refer to the Readme (http://
www.novell.com/documentation/beta/edir871/readme/nwreadme.txt) located in the eDirectory 
8.7.1 online documentation (http://www.novell.com/documentation/beta/edir871/index.html).
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For issues related to using Novell® iFolderTM 2.1 software, see the Novell iFolder 2.1 Readme 
(http://www.novell.com/documentation/lg/ifolder21/index.html).
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Infrastructure (NICI)

NetWare® 6.5 Public Beta

The version of NICI shipping with this release contains components, such as xengexp or xengusc, 
that might abend under low memory conditions when running on Intel* P4 or later processors. 
There is no workaround at this time. To avoid this condition, you should ensure that the NetWare 
server does not run out of memory.
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Apache2 for IPv6

To use Apache2 for IPv6, copy the winsock NLMTM files from sys:\research\ipv6\winsock to 
c:\nwserver. Also copy the folders and NLM files from sys:\research\ipv6\apache2 to 
sys:\apache2.   

Deleting Boards

If there are multiple boards of the same type, removing one board might result in unbinding IPv6 
addresses from all of the boards. This is because the driver unloads and reloads when a board is 
deleted.

Range Checking

Range checking for the variables in ip6.cfg and rtadvd.cfg is not yet implemented.
Novell IPv6 61



Novell Confidential novell_ipv6.fm last saved  4/12/03 Manual Version: 3/17/03103
62   NetWare 6.5 Public Beta Readme



Manual (ENU) 3/17/03103Novell Confidential novell_jvm.fm last saved  4/12/03
28 Novell JVM for NetWare

Changes to the Taskbar Menu

Changes you make to the Novell® JVM* for NetWare® GUI do not immediately appear on the 
taskbar menu. You must close and restart the GUI for the changes to occur. To close the GUI, use 
the Close GUI menu command. To restart the GUI, use the startx console command.
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Location of Beta Licenses

Licenses for NetWare® 6.5 Public Beta are included in the \licenses directory on the NetWare 6.5 
CD 1 (Operating System) and the NetWare 6.5 CD 2 (Products). All licenses, except for Demo 
licenses, expire on September 30, 2003. Demo licenses expire 90 days after installation.

The licenses included with this beta are listed below:

Installing Server Licenses

The server license certificate can be installed in multiple containers of a Novell eDirectoryTM tree, 
but the license certificate can be installed only once in the same container. 

The license will support servers installed in that same container or below it.

Suspect Server Health

Because of the Beta license, the status (traffic light) for Server Health will be yellow (Suspect). 
Removing Licensing Information from the items that the server tracks for health status can remedy 
this situation. 

To change the health status:

1 Click Health Monitor.

2 In the Include column, uncheck the Licensing Information check box.

3 Click Apply.

License Description 

Demo A 5-user license that includes a 
NICI foundation key and a server 
license. 

MLA Unlimited user license.

NWCS Novell® Cluster ServicesTM 
licenses.

SR_XXUSR Hard-stop user licenses, where 
XX represents the number of 
licenses.

SRV_ONLY Server license, which can be 
installed multiple times in the 
same tree and container.
Novell Licensing Services 65



Novell Confidential novell_licensing.fm last saved  4/12/03 Manual Version: 3/17/03103
66   NetWare 6.5 Public Beta Readme



Manual (ENU) 3/17/03103Novell Confidential novell_modular_auth.fm last saved  4/12/
30 Novell Modular Authentication Service (NMAS)

NMAS Messages on NetWare 6 Servers

Netware® 6.5 introduces new NMASTM login methods. After a Netware 6.5 server is added to a 
Netware 6 tree, Netware 6 servers with a replica will display the following message on the console:

NMAS-2.54-11 NMAS.NLM could not load method new_method_name

This message appears because NMAS on NetWare 6 will try to load the unrecognized new 
methods introduced by Netware 6.5.

You can ignore the message.

NICI Client

You must have the NICI Client installed on each client that will run ConsoleOne® and NMAS 
software.

Simple Password and Force Password Change

The Simple Password method is used for various authentication services in NetWare 6.5. This 
includes the authentication support for CIFS and AFP.

A problem might arise if you set or change a user’s simple password from the ConsoleOne 
administrative snap-ins using Force Password Change. If you experience problems setting an 
initial password, you might need to check the Force Password Change check box. If the user 
already has a password set, Force Password Change might not work unless you remove the current 
password and specify a new one.

Explicit Rights and Graded Authentication

You must give explicit rights to users with graded authentication. Inherited rights do not work. For 
example, an administrator’s Supervisor right is defined at the [Root] container. Rights for the 
administrator are not defined in the Volume object. So if the administrator changes the volume’s 
security label from Logged In to any other security label, the administrator cannot get the 
appropriate rights. The administrator must assign explicit rights to the volume, directories, or files 
in the volume.

Universal Smart Card Login Method

The Universal Smart Card login method does not work in this release. It should not be installed.

Simple Password

The Simple password should not be set for a user from ConsoleOne if that same user will be self-
enrolling with the Enhanced Password Method.
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R/W Replica Required

For products to use NMAS login methods properly, at least one NetWare 6.5 server in the 
eDirectory partition needs to hold a R/W replica.
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The Novell® Native File Access Protocols issues are divided into the following sections:

“General Issues” on page 69

“Macintosh/AFP Issues” on page 70

“Windows/CIFS Issues” on page 71

“UNIX/NFS Issues” on page 72

General Issues
CIFS, AFP, and NFS Protocols Installed by Default

The CIFS, AFP, and NFS protocols are now installed by default when you install your NetWare® 
6.5 server. The only exception to this is if you select the DNS/DHCP installation pattern, in which 
case CIFS, AFP, and NFS are not installed.

Uninstalling the Software

Uninstall is currently not supported from ConsoleOne® or NWCONFIG for AFP, CIFS, and NFS. 

To disable CIFS, AFP, and NFS, complete the following steps on each server running Novell® 
Native File Access Protocol software:

1 Run afpstop, cifsstop, and nfsstop at the server console.

2 Remove the AFPSTRT, NFSSTART, and CIFSSTRT lines from the autoexec.ncf file.

Intermittent Java Fatal Error

When the installation progress bar shows 100% copy and processing settings, the following error 
might occur: 

A fatal error has occurred. This program will terminate. You may check 
sys:\ni\data\ni.log for more details after you dismiss the dialog com/novell/
admin/ns/nds/jndi/ndsnamespaceImpl.

If this error occurs, terminate the installation and try again.

Nmas.dll Could Not Initialize Cryptographic Services (-1461)

If any of the following errors appear when launching ConsoleOne, you need to install NICI Client 
2.6 or later on the administrator workstation:

NMAS.DLL could not initialize cryptographic services or cryptographic 
services are not available. (-1461)

NMAS.DLL is unloading b/c of errors during initialization. 

The library NMASWrap could not be located.
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Macintosh/AFP Issues
AppleTalk Not Supported as a Transport Protocol

Older Macintosh* applications that have unique dependencies upon AppleTalk* as a transport 
protocol must be updated to a version that is known to work over TCP/IP. The AppleTalk stack 
protocols (TLAP, ELAP, LLAP, DDP, RTMP, AEP, ATP, NBP, ADSP, ZIP, ASP, and PAP) are 
not supported over TCP/IP by Apple*. 

Therefore, Novell does not support those legacy protocols. Both Novell and Apple have embraced 
TCP/IP as the Internet standard transport protocol.
IMPORTANT: Older NetWare for Macintosh and Prosoft versions of afp.nlm and appletlk.nlm are not 
supported. Do not attempt to mix old Macintosh NLMTM programs with the new afptcp.nlm.

Mac OS 8.x Will Not Mount Volumes Checked to Mount at Startup

Mac OS 8.x will not mount volumes checked to mount at startup. To resolve this, add the server 
volume’s alias to the StartUp Items folder inside the System Folder on the Macintosh’s local 
startup disk.

0x01 Filenames and NSS Volumes

Certain extensions and control panels (such as MacAdministrator) use filenames beginning with 
0x01 to ensure that they load first. These filenames will not work correctly on an NSS volume.

Unloading AFPTCP.NLM and WSPDSI.NLM Programs

The Winsock component used by the Macintosh Native File Access NLM does not always clean 
up all open sockets. If you unload AFPTCP.NLM and then explicitly unload WSPDSI.NLM, you 
might get the following warning in flashing red text:

WARNING!!!

1 active Winsock 2 DSI socket session(s)

Unloading WSPDSI.NLM with active session(s) will abend the server.

Unload all Winsock 2 apps with active SSL socket session(s).

Unload module anyway?

Do not unload the module or the server will abend.

The warning is correct. WSPDSI assumes there are still active AFP sessions and it will abend the 
server if you unload it. The last line of the warning should read "Unload AFPTCP.NLM" but, 
because AFPTCP is already unloaded, unloading AFPTCP will have no effect.

There is no need to unload WSPDSI manually. AFPTCP.NLM loads it automatically on startup 
and AFPSTOP.NCF does not unload it. It remains loaded. Under normal use, you should not see 
this warning.

Traditional Volume Access Not Supported

Native File Access for Macintosh is supported only on NSS volumes. Traditional volumes will not 
be available to Macintosh users.

Do Not Use File or Folder Names Longer Than 98 Characters

Any folder that contains a file or folder name that is longer than 98 characters will cause the 
enumeration of that folder to fail, and the contents of that folder will not be displayed.
70   NetWare 6.5 Public Beta Readme



Manual 3/17/03103Novell Confidential novell_native.fm last saved  4/12/03
Problems with Extended ASCII Characters in File and Folder Names

Extended ASCII characters used in file and folder names created from Mac OS 9 machines might 
not work as expected. The extended characters in the name might be changed. On Mac OS X, the 
names work as expected.

Windows/CIFS Issues
Workstations Might Not Be Able to Access a Windows 2000 Primary Domain Controller

If the Primary Domain Controller (PDC) is a Windows 2000 server, Windows workstations might 
not be able to access the CIFS server. To fix this:

1 In ConsoleOne, go to the CIFS Config property page for the Server object and ensure that the 
Authentication Mode is set to Domain and that the Domain name is set correctly.

2 Enter the Name and IP Address for the Primary Domain Controller

3 Enter CIFSSTOP and then CIFSSTRT at the server console.

PDC and CIFS on Different Subnets

If the PDC and CIFS servers are on different subnets, you must specify an IP address for the PDC 
on the CIFS Config property page for the Server object.

Password Changes

Trying to change a password from a Windows 9.x or NT4 client workstation might fail if the 
default network username and password in the client’s cache are not a valid combination on the 
CIFS server where the password change was attempted. 

To avoid this problem, validate the username and password combination in the client’s cache on 
the CIFS server before attempting the password change. You can validate by attempting to access 
the file system on the CIFS server by browsing to Network Neighborhood. 

Configuration File Options Not Supported

In ConsoleOne, two configuration settings for Unicode and Oplocks are displayed and in previous 
releases were able to be changed. In this Public Beta release, these options are still displayed, but 
they are enabled by default and cannot be disabled. Checking or unchecking the check boxes has 
no effect.

Support for Unicode and Oplocks is now fully integrated into cifs.nlm and is always on. If the 
client sends path strings in Unicode, those strings are used directly by the NSS file system with no 
translation to or from ASCII. If the client requests Oplocks, the request will always be honored. If 
you want to turn off Oplocks, you must do it at the client.

CIFS Server Not Visible in Network Neighborhood

You might occasionally find that your CIFS server is not visible using Network Neighborhood. 
This can happen if you have a domain that contains only Windows 95/98 and no NT/2000/XP 
servers or clients. To correct this problem, enter the server name or IP address in Find Computer.

Traditional Volume Access Not Supported

Native File Access for Windows is only supported on NSS volumes. Traditional volumes will not 
be available to Windows users.
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UNIX/NFS Issues
NFS Server

Export of traditional volumes is not supported.

If the NetWare server code page is 932, then the file creation from Japanese EUC NFS clients 
fails for certain characters.

When you modify the export options of an exported path, unmount all client mounts for that 
path and remount them.

When you remove the path from the export list, unmount all client mounts for that path.

The rm -rf command fails over NFS version 3 over TCP.

Hardlinks are not supported in this release.

Exported paths cannot contain spaces. However, filenames and directories containing spaces 
can be created and used under the exported path.

In NFS clients of IBM AIX 4.3 and earlier, there might be issues in simultaneous acquiring 
and releasing of locks over the same region of a file from two different processes.

To avoid the issues, use AIX 5.0 or later NFS clients.

Using NPS Gadgets for Administering NFS Server

The appearance of NPS Gadgets varies in Internet Explorer 6 and Netscape Navigator 7.0.

A disabled path can be edited from the Netscape browser.

The OK, Cancel, Add, and Remove buttons do not function in Edit Path Properties for a path 
with 40 or more trustees.

Localization of NPS Gadgets

The NFS Server Administration page is not available when the browser is set to some 
languages.

Operations such as modifying umask value, exporting a new path, or modifying existing path 
properties cannot be done in certain languages.

Exporting a path containing Japanese characters from UI is not supported.

The NFS Server UI does not function correctly when NetWare 6.5 is installed in Portuguese.

Error 9600

NDSILIB might not autoload in certain instances. If this happens, it will return Error 9600. To fix 
this problem, run NFSSTOP at the server console and then execute the operation again.

Makenis Issues

When running makenis on a server with no DS replica and when the Master replica is down, 
a series of messages similar to the following are displayed erroneously:

Nullpointer passed to routine Kmutex

Do not use makenis to delete users and groups. Use ConsoleOne instead.

Making a NetWare 6.5 server an NIS slave server might abend the server.

This will be resolved in the FCS release.
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Pkernel Messages

If the pkernel screen displays messages similar to the following after executing yppush, ignore 
them. They do not affect functionality.

Out of memory, cannot create UDP Client handle.

Removing Users or Groups from the NetWare NIS Slave Server

When the NetWare server is made a slave NIS server and users and groups are deleted from the 
master NIS Server, do the following to remove the users and groups from NetWare NIS slave 
server:

1 From the ConsoleOne main menu, right-click the User or Group object.

2 Click Properties > Other.

3 Under Attributes, select nisUserGroupDomain and then select the specific domain.

4 Click Delete.
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WebDAV Support

NetDrive supports secure HTTP (HTTPS) for WebDAV only on Windows NT 4/2000 and 
Windows XP workstations.

Using the NetDrive Client behind a Firewall Regulated by BorderManager

If your NetDrive client is behind a firewall regulated by a BorderManager® server that is 
configured for FTP proxy and authentication, NetDrive cannot map a network drive via FTP to 
any servers that reside outside the firewall. To solve this problem, disable the FTP proxy 
authentication on the BorderManager server.
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NetWare 6.5 56-Bit International Versions Must Use iFolder 1.03

Novell® iFolder® 2.1 does not support 56-bit encryption. If you are using 56-bit encryption in an 
international version of NetWare® 6.5, you must use iFolder 1.03 to enable users to access their 
iFolder files using NetStorage.

Logging In as a Different User

If you are using Windows 98 and Internet Explorer, and after logging in to NetStorage you intend 
to log in again as a different user, you must first delete Internet Explorer cookies and log out from 
Windows 98 or you will not be able to log in again. This is necessary because Windows 98 retains 
user information and NetStorage cookies are created that are user specific. 

When using Windows 2000 and Microsoft Web Folders, you must enable the Launch Folder 
Windows in a Separate Process option:

1 Double-click My Computer, then click Tools > Folder Options > View. 

2 Check the Launch Folder Windows in a Separate Process check box.

Internet Explorer Unable to Open Some Web Folders

If you use Microsoft Web Folders with NetStorage to create a new folder, you might not be able 
to open that folder using Internet Explorer.

NetStorage Help Not Accessible When Using NetWare WebAccess

NetStorage online help is not accessible when both of the following conditions exist:

You access NetStorage using NetWare WebAccess

NetStorage and NetWare WebAccess are installed on different servers 

Character Set Issues with Netscape

If you use the Netscape browser to open NetStorage, square boxes will be displayed in place of 
some characters. To resolve this, click View > Character Set > Unicode (UTF-8), and then click 
View > Character Set > Set Default Character Set. 
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Pre-Installation

Before you install NsureTM UDDI Server, make sure Novell® eDirectoryTM is set up correctly.

Ensure the ldapTLSRequired option has been disabled:

1 In iManager, click the LDAP Management role, then click the LDAP overview task. 

2 Select the View LDAP Groups page, then click the group object and disable the Require TLS 
for Simple Binds with Password option.

3 Select the View LDAP Server page, click the server object, then click Refresh.

Installation

Enter the following command at the server console:

path to uddiInstall.ncf\uddiinstall.ncf path to 
UDDIInstall.jar\uddiInstall.ncf

Post-Installation

Optional:

To allow publishing in an SSL setup, set EnforceSSLForPublish=yes in the 
configdir\conf\uddi.conf file, where configdir is the directory selected during installation.

To allow inquiries in an SSL setup, use the Allow Authenticated Inquiry over a Non-SSL Channel 
option (change it to False) and configure your Publish and Inquiry URLs accordingly. For more 
information on configuring this option, see Using the UDDI Administration Interface in the UDDI 
Administration Guide.

Configuration Verification:

Test the UDDI server by typing the following in a Web browser:

http://hostname:portnumber/novelluddi/servlet/rpcrouter

where hostname is the hostname or IP address of the server and portnumber is its port number.

The following message will be displayed in your browser window if the UDDI service is running:

UDDI Server Status

Server Initialized Successfully.

This completes the UDDI server setup. Next, you should create the UDDI roles and tasks in 
iManager in order to start working with the UDDI administration and user access interface tasks.
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Known Issues

Do not use the browser’s Back and Forward buttons for navigating through the UDDI 
administration and user access interface. Instead, use the navigation provided within the 
application.

The Publish operations do not work with eDirectory 8.6.22. You will need to upgrade to 
eDirectory 8.7.

If the same user authenticates to the UDDI server from multiple workstations, performing a 
discard_authtoken (logout) on any one of these workstations will log out all the current 
connections established by that user; the operation that is in progress will not be affected. We 
recommended that you do not allow using the same user identity from multiple workstations. 

The UDDI server invalidates requests from the JAXR browser (JWSDP1_0_01) because of 
the inclusion of empty tags for some omitted optional attributes. However, the UDDI requests 
sent by other clients using the JAXR interfaces are fully supported.

The UDDI administration and user access interfaces provided through Novell iManager are 
recommended for a typical usage of 10-20 users accessing the UDDI registry simultaneously. 
At higher loads, it has been observed that a memory buildup on the iManager server 
drastically slows down the response to the clients.

The basic look-and-feel of the utility differs from one browser to another, including the 
following:

Fieldsets (for example, the Inquiry and Publish fieldsets on the Set Rights for UDDI Base 
Context page in the Access Management)

Tabbed options

Width of the list boxes (combo boxes)

Size of the frames and relative separation

Changes in the GUI appearance within a fieldset are not displayed (such as changing the 
label of a control or enabling/disabling a button). However, the functionality remains in 
tact.

For instance, this happens when you check the Public check box on the Set Rights for 
Base Context page in the Admin Access Management. The Object Selector should be 
disabled. Functionally, this disabling occurs, but it is not visible to the user.

On Netscape Navigator 7.0, only a single object can be selected using the Object Selector 
icon. 

On Netscape Navigator 7.0, the online help icon is displayed only if you are using iManager 
1.5.1.
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Previous NetWare 5 NSS Volumes Not Automatically Upgraded

Previous NetWare® 5 NSS volumes are not automatically upgraded during the NetWare 6.5 
installation process. After you install NetWare 6.5 and reboot the server, you can upgrade pre-
existing NSS volumes to the current NetWare 6.5 NSS volume layout. 

Before you upgrade previous NSS volumes, make sure that Novell® eDirectoryTM is running and 
that the Backlink process is complete. (For instructions, see Upgrading and Copying Volumes in 
the Novell Storage Services Administration Guide.)

To upgrade previous NSS volumes: 

To upgrade a single NSS volume, at the server console, enter

nss /zlssvolumeupgrade=volume 

To upgrade all NSS volumes, at the server console, enter

nss /zlssvolumeupgrade=all

After you upgrade the volumes, you can either use the Mount All command or mount the volumes 
individually.

Must Add Trustee Rights to sys:login When Upgrading Volume sys:

You can use the volume conversion utility called Volume Copy Upgrade (VCU) to upgrade a 
traditional volume sys: to the NSS volume sys:. However, the implied trustee rights do not transfer 
with this method. After you upgrade volume sys:, you must manually add a public trustee with 
Read and File Scan rights to the sys:login directory.

Do Not Create Traditional Volumes during a Cluster Upgrade

Do not create new traditional volumes on NetWare 5.1 servers when upgrading a cluster from 
NetWare 5.1 to NetWare 6.5.

After one NetWare 5.1 server in the cluster is upgraded to NetWare 6.5, upgraded NSS volumes 
on shared storage might appear as free space in a traditional partition. Creating a volume on the 
free space will corrupt the NSS volume.

NSS volume corruption occurs if all of the following conditions exist on your system:

The Prepare a Novell Cluster for Upgrade option in the Deployment Manager was run and 
completed.

At least one of the NetWare 5.1 servers in the cluster was upgraded to NetWare 6.5.

One of the NetWare 5.1 servers not yet upgraded was rebooted and an attempt was made on 
that server to create a traditional partition using the nwconfig command.
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Junction Levels Limited on Windows Systems for DFS

On Windows XP and 2000, DFS works only one junction level deep. 

On Windows 98 and NT 4, the junction levels can be as deep as are supported by the length of a 
Windows path.

Hot Fix Support

Hot FixTM support has been removed from NetWare 6.5 because it is no longer necessary; storage 
devices typically provide their own hot fix solutions.

Most NSS Storage Management Functions Moved to iManager and NSSMU

Effective in NetWare 6.5, you can perform most storage management functions only in iManager 
and NSS Management Utility (NSSMU). Storage management functions are no longer available 
in ConsoleOne®. Storage interfaces in ConsoleOne refer you to the browser-based iManager and 
the console-based NSSMU for NSS storage objects or to NetWare Remote Manager (NRM) for 
Novell Traditional File System storage objects.

Exceptions to this change are the interfaces for setting up the DFS Management Context and 
Junctions and viewing the NSS Volume Location Database (VLDB) servers. These options are 
still in ConsoleOne.

This change does not affect Novell Cluster ServicesTM options in ConsoleOne.

Floppy Disk Error in the Device Management Page in iManager

If a floppy drive exists on the server, the Devices Management interface incorrectly displays it in 
the Devices list. If you select that floppy device, iManager refreshes the page with no device 
selected and the Details area empty.

In the final release, the iManager interface will screen out floppy devices; they will not appear in 
the Devices list.

How to Refresh an iManager Page

To refresh the page you are viewing in iManager, click the link to that page in the left-hand 
navigator. 

If you click the browser’s Refresh button or Back button, the browser returns you to the initial 
iManager page that is retrieved upon login.

Specifying VLDB Servers for the DFS Management Context

In NetWare 6.5, you can specify up to two VLDB servers in the DFS Management Context and 
they must be in the same LAN. Because ConsoleOne does not log into the VLDB server 
automatically, your setup might not take effect.

To avoid this problem, connect to the servers before you designate them as VLDB servers. For 
example, map drives from the servers to your local workstation or server where you are working. 
Then, simply select the servers to be your VLDB servers as you create the DFS Management 
Context.

You can also run ConsoleOne directly on the server that you want to make a VLDB server when 
you are setting up VLDB servers for your DFS Management Context. To add a second server, run 
ConsoleOne on that server, open the server’s property page, then click Add Replica.
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ConsoleOne File Menu Issue for the DFS Management Context

The File menu on the ConsoleOne main tool bar allows you to create a DFS Management context 
in a container that is already defined as a DFS Management context. The option should be dimmed 
for a container that is already configured as a management context.

Start VLDB Repair from the Server Console after Creating a DFS Management Context

If you are creating a DFS Management Context using ConsoleOne, you must start the VLDB 
Repair command from the server console immediately after creating the DFS Management 
Context; do not start it from ConsoleOne. This is particularly important if you have servers and 
volumes in different containers in the tree because the server you start VLDB Repair on must be 
a VLDB server.

If started in ConsoleOne, the VLDB Repair logs in to eDirectory as the server that ConsoleOne is 
running on, and that server might not have sufficient rights to do everything it needs to do. If you 
attempt to create a new junction on a server in the tree that is not a VLDB server, you might get 
this error: The junction, junctionname, could not be created because 
servername_volume.context does not contain the DFS attribute.

If started from the server console, VLDB Repair prompts for a username and password, then runs 
as the user as it walks the tree.

The need for this manual start of VLDB Repair will be fixed in a later Support Pack release when 
VLDB administration is removed from ConsoleOne and supported in iManager.

Disable Login on a Server before Using Move Volume or Split Volume

The NSS Move Volume and Split Volume commands do not track any changes made to files that 
might be in use during the Move or Split job. Any such changes are lost.

For example, a file might be changed after the original file is copied to the new volume but before 
it is deleted from the original volume. Any changes made during that time are lost. 

Another example is if the original volume has the attribute set for File-level Snapshot. Because the 
Move and Split functions make use of the Storage Management ServicesTM (SMSTM) backup and 
restore utilities, the File-level Snapshot attribute would automatically enable SMS to copy old 
versions of files from the original volume to the new volume even if they are in use during the 
transfer. Any the changes made to the files during that time are lost.

To avoid losing changes made to files during a Move or Split job, keep users and applications from 
using the original volume while the job is running.

For example, issue the Disable Login command from the console to keep users from logging in to 
the server, then use NetWare Remote Manager (NRM) to issue a Drop Connections command to 
kill any active connections. 

Alternatively, you might issue an advisory to users to request their voluntary cooperation for the 
duration of the Move or Volume job. Make sure to address any active APIs that interact with the 
volumes.

Pool Multiple Server Activation Prevention

If enabled, the pool Multiple Server Activation Prevention (MSAP) prevents some accidental 
activations of a pool on more than one server at a time. It will not catch all multiple activations. 
You should never purposely attempt to activate a pool on two servers at the same time. MSAP is 
not meant as a replacement of clustering software that controls shared pools.
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In some cases, the MSAP software causes pools to take up to 30 seconds to activate. This delay 
might occur on the next pool activation after the Server ID or the Cluster ID changes for a given 
server pool. The Server ID changes if the registry is corrupted. The Cluster ID changes if the 
Cluster NDS object ID is lost.

If MSAP is enabled, all active ZLSS pools will be read every 14 seconds. If your storage media 
are not shared between multiple servers such as in a SAN, you can clear the zpool_feature_msap 
bit. You should not clear this bit if your pools are on physically shared storage media.

If a pool can be accessed by older servers not running the Support Pack with the MSAP software, 
then multiple pool activations can still occur.

MSAP does not protect against partition conflicts for pools. It does not prevent multiple servers 
from creating a pool in the same partition.
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Fault Tolerance

Fault tolerance is supported on ODITM compliant drivers, such as CE100B, IBMFE, 
PCNTNW, 3C90XC, and N100.

Fault tolerance does not work for multicast applications. When the NIC which contains the 
multicast group address information goes down, the multicast group address information is 
not transferred to the other members in the group. For example, applications like SLP will not 
work when the associated NIC goes down.

Virtual IP

Virtual IP currently works only in an environment configured for RIP-based routing.

Virtual IP will not work with applications that time out before the Routing Expiration Time 
Out Interval. Therefore, the applications will not get a chance to switch to the next-best hop 
for the route. For example, NCPTM and GroupWise® applications will time out before the 
routing expiration takes place and they will need to re-establish their connections. 

Configuration through INETCFG

If the netinfo.cfg file is corrupted and upon loading INETCFG you get a message asking you 
to reconfigure, delete the tcpip.cfg file.

After the network configuration of the server is complete, we recommend that you back up 
the netinfo.cfg, netinfo.chk, and tcpip.cfg files located in sys:\etc. Then, in case of corruption, 
you can restore from the backed-up configuration.

In machines with multiple NICs, when already-in-use IP addresses are selected for binding, 
an ARP conflict error message for each binding is displayed in the logger screen. The system 
should automatically trigger unbinding of the IP addresses. If the binding persists,               
manually delete the bindings and reinitialize the system.

Supernetting

After a server is configured as a router (forwarding enabled), it cannot be configured with a 
supernet mask. Therefore, if a server is configured with a supernet mask, forwarding is disabled. 

If the mask is changed to a nonsupernet mask and the system is reinitialized, the INETCFG 
protocol configuration indicates that forwarding is enabled, even though it is not. To re-enable 
forwarding, you will need to make an explicit configuration change in INETCFG.

To verify the status of forwarding, check the Forwarding tab in TCPCON. 

Ipflt.nlm

If more than one board is bound to the same IP address, the filter should be configured for all 
boards; otherwise filtering will take place only for the configured member. 
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NIC Teaming

Currently, only one user-specified protocol is supported.

Iptrace.nlm

The iptrace.nlm program will not be able to display the information of traces where destination 
addresses and intermediate hops do not respond to the source. 

NetWare Internetworking Remote Manager 

The following functionality is not supported in NetWare® Internetworking Remote Manager: 

new boards configuration

BOOTP

EGP

SNMP

Import or export of configuration files across servers or to the client machine

Per-Packet Load Balancing 

To maintain communication, the card properties (such as checksum, offloading, and support) 
should be the same.

All cards on the same network should be grouped; otherwise, the packet will also reach an 
ungrouped member.

Command Line Utility Limitations

Routecon is not fully functional in this release. 

Default Routing Configurations

IP packet forwarding is disabled. The NetWare server will work as an end node.

RIP is disabled. The server will not be able to listen and transmit RIP routes.

LAN Static Routing is enabled. When NetWare is installed with the default gateway and you 
load INETCFG for the first time, the gateway information will be transferred to \etc\gateways. 
Therefore, when LAN Static Routing is enabled by default, the default gateway from 
\etc\gateways will be activated as the default route.

Pragmatic General Multicast (PGM)

PGM is a reliable multicast transport protocol that works on a multicast-enabled network. 
Therefore, the network from the PGM sender to all the PGM receivers should be multicast enabled. 
If there are any routers on the path between the sender and the receivers, multicast forwarding must 
also be enabled in them.
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37 Nterprise Branch Office Appliance

See the Novell® NterpriseTM Branch OfficeTM Readme (http://www.novell.com/documentation/lg/
nbo/index.html?page=/documentation/lg/nbo/readme/data/agfitbb.html) for issues related to 
Nterprise Branch Office.
IMPORTANT: Before installing a central office NetWare® 6.5 server and installing Nterprise Branch Office on 
appliance hardware, you should familiarize yourself with Nterprise Branch Office and specific requirements for 
the central office server. See the Nterprise Branch Office documentation Web site (http://www.novell.com/
documentation/lg/nbo/).
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38 NTPv3 RFC 1305

Known Issues

The ntp.drift file does not get updated.

Configuring NTP using Monitor and DSREPAIR -T is not implemented in this Beta.

XNTPD accepts only lowercase letters in the ntp.cfg file.
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39 OpenSSH on NetWare

Error Reported during Remote Upgrade

If you perform a remote upgrade, OpenSSH will report an error trying to configure the product.   
To fix the configuration problems, edit sys:\etc\ssh\sshd_config and update the default 
NDS_TREE and .NDS.CONTEXT tags with the admin user’s tree and context. You also need to 
add users who you want to have rights to administer OpenSSH to the sshadmn-Administrators 
group.

A local (from the GUI on the server) post-install of the OpenSSH product will also correct the 
configuration issues.
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The New Password is Case Sensitive

When using the Novell® 4.9 Client, passwords are case sensitive. The first time a user logs in with 
the Novell 4.9 Client, the password is validated and then set using the case-sensitive password as 
provided by the user. If the user logs in first with CIFS or AFP, the CIFS/AFP password (the simple 
password) will be used to set the new password.

The NetWare 6.5 installation also performs this password migration for the user that is performing 
the installation or upgrade. In this Public Beta release, when upgrading to NetWare 6.5, the admin 
password is uppercased before it is set. If the administrator that performed the upgrade attempts to 
log in using the password in lowercase, the authentication will fail.
Password Enhancements 93



Novell Confidential password_enhancements.fm last saved  Manual Version: 3/17/03103
94   NetWare 6.5 Public Beta Readme



Manual (ENU) 3/17/03103Novell Confidential pervasive.fm last saved  4/12/03
41 Pervasive.SQL

Insufficient Memory Might Cause a CPU Hog Abend

If Btrieve* doesn’t have enough memory allocated when it’s loaded on the NetWare® server, it 
could result in a cpu hog abend. The abend information will indicate that nwmkde.nlm abended in 
GetCacheBuffer.

The default memory requirement is 2 MB. However, Pervasive* recommends at least 10 MB 
(preferably 20 MB). 

You can increase the Btrieve memory requirement in the sys:system\bti.cfg file by modifying the 
CacheSize=2024 parameter.

Pervasive.SQL 2000 Database Licenses

A permanent two-user license is installed during the NetWare 6.5 installation process. If you are 
upgrading an existing NetWare server, an unlimited license that will expire 90 days after 
installation is also installed. 

The permanent two-user license is intended for use by the NetWare operating system. If you have 
additional applications using Pervasive.SQL 2000 or Pervasive.SQL 2000i, including the Btrieve 
interface, you can use the unlimited user count license for 90 days. If you have applications that 
need access to the NetWare Pervasive.SQL 2000i database engine, you must purchase an 
appropriate user count license from Pervasive Software before the 90-day evaluation period ends. 
Allow adequate time before the end of the evaluation period to receive your user count license.

For more information on Pervasive.SQL 2000i and its features, documentation, or information:

Internet: Pervasive Software Web site (http://www.pervasive.com) 

Email: Salessupport@pervasive.com

Phone (U.S.): 1-800-287-4383

Phone numbers for all international offices are available from the Contact Us link (http://
www.pervasive.com/company/contact/index.asp) on the Pervasive Software Web site.

Known Issues

In order for Pervasive to update known issue reports between releases, all Known Issues are 
published in the Pervasive Knowledge Base (http://support.pervasive.com/eSupport/). Search on 
"Pervasive.SQL 2000 Service Pack 3 known issues".

You can also see a static list of known issues, including links to the associated Knowledge Base 
articles, at the Fixed Defects and Known Issues Web page (http://www.pervasive.com/support/
updates/psql2kfixed.asp).
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Technical Support

For technical support and discussions about Pervasive products, see the DevTalk forum (http://
www.pervasive.com/devtalk).

To file a support incident, submit an Electronic Support Incident (http://www.pervasive.com/
support/support_email.asp).

You can also visit the Pervasive Support Center (http://www.pervasive.com/support/
supportcenter.asp) for other contact information.

Useful Links

Comprehensive list and details of Pervasive products (http://www.pervasive.com/offerings)

Discussions about Pervasive development issues (http://www.pervasive.com/devtalk)

Technical papers (http://www.pervasive.com/support/TechPapers.asp)

Online product manuals (http://www.pervasive.com/support/technical/online_manuals.asp)

Support programs (http://www.pervasive.com/support/support_programs.asp)

Pervasive Knowledge Base (http://support.pervasive.com/eSupport/)

Updates and patches (http://www.pervasive.com/support/updates/)
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42 Scripting Products

Scripting Products Included

The following scripting products are included with NetWare® 6.5. Additional Readme information 
is located on the Novell® Developer Web site.

PHP (recursive synonym of Hypertext Pre-processor) (http://developer.novell.com/ndk/
readme/php.txt)

Perl for NetWare (http://developer.novell.com/ndk/readme/perl5.txt)

Novell Script for NetWare® (NSN) (http://developer.novell.com/ndk/readme/nscript.txt)

Universal Component System (UCS) (http://developer.novell.com/ndk/readme/ucs.txt)

Upgrading from NetWare 6.0 to NetWare 6.5

NetBasic* 6.0 is not installed as a part of NetWare 6.5. If you are familiar with NetBasic 6.0 
and shell commands, use NSNINIT and NSNSHELL instead.

PHP

UDP functions are not yet stable and might cause the server to abend.

If fsockopen() fails, a memory leak and abend might result.

Environment implementation (getenv, putenv, etc.) is dependent on the underlying LibC 
implementation.

The Mail functionality will not work if the SMTP Server Name is specified instead of the IP 
address for the SMTP variable under the [mail function] section in php.ini file.

When an infinite or a recursive script is run from one browser, running even a simple script 
from another browser simultaneously might abend the server.

Stopping an infinite script by unloading Apache at the server console might cause the server 
to hang or abend.

Sorting using string indices might not work properly.

The strtotime() function might not work properly.

For the system() and exec() functions, we recommend that you use only single-quoted strings 
with any combination of slashes to separate directories. For example:

system('sys:\system\rconag6.nlm'); or system('sys:\\system\\rconag6.nlm');

If double-quoted strings need to be used, then also use a double slashes. For example:

system("sys:\\system\\rconag6.nlm");

If double-quoted strings are used with single slashes and if the NLM name starts with the letter 
r, t, n—for example, system("sys:\system\rconag6.nlm");—then the NLM will not load.
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This is because the letters will be considered as \r or \t or \n.

Perl for NetWare

Failure of UCX methods will be indicated by an unknown error. The error description given 
by the UCX call is currently not available for the Perl script.

Complex scripts running from the console might give the message Process did not 
relinquish control frequently.

When multiple Web scripts each doing complex operations are run simultaneously, the Web 
server will hang or abend.

Scripts that contain an infinite loop can be terminated by Ctrl+z, but not Ctrl+c. When Ctrl+z 
is pressed, it breaks the loop and expects any key to be pressed (which will be indicated on 
the Perl output screen) before the Perl output screen can be exited.

Press Ctrl+z after pressing Enter to execute the next command in the Perl debugger.

Scripts that use the Thread and Threads modules might not work as expected.

The truncate built-in procedure does not function reliably.

The readlink built-in procedure always returns an undefined value.

According to Perl’s definition of the function, this is the correct behavior on a system such as 
NetWare that does not support symbolic links.

The Fork method is not yet implemented on NetWare.

The Perl extension to access components through UCS was named UCSExt in Perl 5.003. 
With Perl 5.6 and later it is renamed as Perl2UCS. So, in order for the components to work, 
change UCSExt to Perl2UCS.

We recommend that you use the perl system("nlmname") without the load prefix to load an 
NLMTM. However this method of loading the NLMs does not update the $? variable.

The SYN_TIME NDS attribute returns a string value, but Perl sends double value while 
setting such attributes representing seconds since 1970.

For NetWare 6 and later, executing command line options causes output to be displayed on 
the logger screen.

Novell Script for NetWare

In some cases on multi-processor machines when attempting to access the nsnshell, the screen 
might return to the console and not bring up the shell.

To correct this problem:

1 At the console prompt, enter the following commands:

unload nsninit

ucxstop *

unload _textwin.nlm

unload ucxmgr

2 Then load the following:

nsninit

nsnshell
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This will allow access to the nsnshell. This problem will be corrected in FCS release.

Universal Component System

UCS2UCX (UCS Provider)

Passing parameters to a method which will be updated during the execution of the 
method, used either to return values or otherwise, is not fully supported.

UCS2Java (Java* Provider)

The UCS2Java provider requires JVM 1.2 or later. The earlier versions are no longer 
supported.

In UCS2Java provider, complex data types like Date and Array are not fully supported.

When the script executes, the control will go to the Java GUI screen if the DISPLAY 
environment variable is set to the default value (127.0.0.1:0). For the control to go to the 
Console screen, set the value to 127.0.0.1:1 by entering the following command at the 
console:

ENVSET DISPLAY=127.0.0.1:1

AWT-based JavaBeans* might cause the script to hang while exiting. This is due to a 
problem in JNI, which does not allow the VM to unload if threads are still running.

Final variables in classes (equivalent to constants) are not currently supported.

Java objects cannot be instantiated using constructors with parameters in this Beta. Only 
the constructor with no parameters will be called.

UCS2RMT/UCS2WIN (Remote ActiveX Provider)

If some ActiveX Controls are not compliant to the standard, it might cause some 
problems.

Java2UCS (Java Extensions)

Due to recently incorporated security features in many of the UCX components, many of 
them will not be fully usable from Java programs using Java2UCS. A solution will be 
available in the near future.
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43 Server Consolidation Utility

For additional issues related to the Novell® Server Consolidation Utility, see the Readme located 
in the Novell Server Consolidation online documentation (http://www.novell.com/documentation/
lg/servercon20/readme.txt).

Use the Correct Version of Novell Client

Server Consolidation Utility 2.0 ships with the Public Beta software. This version of the Server 
Consolidation Utility does not work with the version of the Novell Client that ships with the Public 
Beta. Instead, it must be run on a workstation with Novell® ClientTM version 4.83 or version 4.83 
Support Pack 1.

Server Consolidation Utility 2.5, which does work with the version of the Novell Client that ships 
with the Public Beta, is available as a download from the Novell Public Beta Web site (http://
beta.novell.com/public.jsp). To download the software:

1 Access the Novell Public Beta Web site (http://beta.novell.com/public.jsp). 

2 Type your contact name and e-mail address, select BETA - NetWare 6.5, then click Go.

3 Select View Download/Updates, then click Go.

4 Select Server Consolidation Utility 2.5, then click Download and follow the onscreen 
instructions.
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DOWN Command Powers Server Off on Most Pentium 4 Machines

On newer server hardware that provides ACPI (Advanced Configuration and Power Interface) 
support, NetWare 6.5 will auto-detect and load the module acpidrv.psm file that supports 
HyperThreading, if present, and advanced Power Management features.

With the ACPI power management drivers loaded (which they are by default if the hardware 
support is detected) pressing the server’s power button will, in effect, first execute the DOWN 
command (bringing down the server with a 30-second default delay and a message) and then 
power the server off. 

Actually executing the DOWN command at the System Console prompt or from NetWare Remote 
Manager, will also shut down the server and power off the system.

Also note that the RESTART SERVER command includes a power cycle on these same machines 
with ACPI support, equivalent to the RESET SERVER console command.
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Windows TSA and NWBACK32 Support

Novell® has discontinued support for the Target Service Agent (TSA) components for Windows 
and NWBACK32.

TSAFS Module

The Target Service Agent for NetWare® 6.5 (TSAFS) has been redesigned to deliver performance 
and is feature compatible with existing TSAs on previous versions of NetWare. 

TSA Issues
NOTE: tsafs.nlm was named tsa610.nlm in previous NetWare 6.5 Beta releases.

The Scan option Overwrite Existing Dataset If Newer is currently not supported.

If an error occurs during the backup of directory trustee information, a restore of the same 
session might lead to errors or a system hang.

NFS hard links cannot be backed up.

The Generate CRC Scan option is not supported.

If the message Cache memory allocator out of available memory displays 
during backup, reload TSA with a lower value for CacheMemoryThreshold parameter.

ARCserve* does not set the directory space restriction properly while restoring the data from 
NetWare 5.x to NetWare 6.5.

To resolve this, in the GUI, set the Preserve Directory Space Restrictions option to No.

Other Issues

If you select a single file for backup, you cannot use SBCON to rename it during a restore.

You cannot enable eDirectoryTM (NDS®) discovery using iManager. Use the Server console to 
enable it instead.

The RenameDataSet function is not supported on the NetWare traditional file system.
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SMS Compatibility with Third-Party Backup Software

The SMSTM components in NetWare® 6.5 Public Beta were tested with the following:

ARCserve 9.0 for NetWare

VERITAS Backup Exec for NetWare version 9.0

VERITAS NetBackup DataCenter 4.5 GA

Syncsort Backup Express version 2.1.5c

ISA Adapters Are Not Supported

For performance and scalability reasons, all ISA adapter drivers were removed with the NetWare 
6.0 release. There is a possibility that a family driver might support adapters which run on more 
than one bus type (PCI and ISA). In this case, any ISA adapter would be considered a noncertified 
driver and would not be supported by Novell®.

Scsihd.cdm Command Line Options

Scsihd.cdm now has command line options that can customize the behavior of the driver. The 
following is the syntax:

load scsihd <</>option<=value>>

Option Explanation

? Displays the help screen. Can be used only when the driver is not 
loaded because the loader cannot load it if it is already loaded. When 
this option is used, the help screen is displayed on the console screen 
in NetWare 4 and NetWare 5 and on the logger screen in NetWare 6, 
and the driver load fails.

AEN Causes SCSIHD to issue Asynchronous Event Notification HACBs 
(AENs). This, in turn, causes the HAMs that can do so (such as fibre 
channel) to report the loss of a hard disk drive or the discovery of a 
new one even without active IO.

DEBUG Causes SCSIHD to output extra messages to the console screen 
(NetWare 4 and 5) or logger screen (NetWare 6).
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EXCLUDE=value Causes SCSIHD to not support a particular driver model. The model 
name specified in this option is compared with the Product ID field in 
the SCSI Inquiry data. The model name is case sensitive, and partial 
model names are acceptable as long as the truncation is not on the 
left. 

Replace value with the name of a hard drive model that you do not 
want SCSIHD to support. 

Maximum length of model name: 14 (decimal)

Default: do not exclude anything

HELP Same as ?.

REQPOOL=value Causes SCSIHD to create a pool of buffers that can be used in 
addition to the one maintained by NWPA to create IO requests. In 
NetWare 4, performance is enhanced if the driver maintains its own 
buffer pool for requests. In NetWare 5 and NetWare 6, performance is 
faster if the driver uses NWPA’s request pool—unless NWPA's request 
pool frequently becomes depleted, in which case it is better to specify 
REQPOOL and have the driver maintain the pool. 

Overuse of this option unnecessarily uses up memory. This option 
should be used only by those who have a highly technical knowledge 
of NetWare.

Replace value with the number of buffers that SCSIHD should 
maintain in its pool before it tries to allocate new buffers from the 
operating system. 

Range: 1 to 99,999 (decimal)

Default: 0

RETRIES =value When an IO error occurs that is caused by hardware failure, SCSIHD 
tries to jumpstart the device back to life with a combination of Test Unit 
Ready and Start Device SCSI commands. If successful, SCSIHD 
retries the original request that failed; otherwise, the disk drive is 
deactivated to protect the data on it from corruption. 

Replace value with the number of retries that SCSIHD should attempt 
without success before it deactivates the drive. 

Range: 1 to 999 (decimal)

Default: 3 (decimal)

RETRYDELAY=value Between retries of the Test Unit Ready and Start Device SCSI 
command combination, SCSIHD delays for the number of seconds 
specified by this option. 

If recovery of the failed device is not successful, the RETRYDELAY 
value multiplied by the RETRIES value determines the amount of time 
that a device is deactivated after the hardware error is reported. This 
time amount could be distorted by the HAM driver doing its own retries. 

Replace value with the number of seconds SCSIHD should delay.

Range: 1 to 999 (decimal)

Default: 10 (decimal)

Option Explanation
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Known Issues and Limitations

Timesync in a forced scenario might not work in some setups.

To resolve this:

Set Timesync Configured Sources = ON

Specify the IP address, DNS name, or fileserver name of the time source in the Timesync 
Time Sources parameter. 

The Monitor screen hangs for a minute if an invalid IP address is given as time source and the 
RESET flag is pressed.

Change in Timesync Default Configuration for Secondary Servers

When you add a second NetWare 6.5 server into a tree, the default Timesync configuration is 
as follows:

Timesync Configured Sources = ON

Timesync Time Sources = IP address of the master replica of the 
tree:123

When you add subsequent NetWare 6.5 servers into a tree, the default Timesync configuration 
is as follows:

Timesync Configured Sources = ON

Timesync Time Sources = IP address of the read/write replica of 
the tree:123

Troubleshooting Tips

If your server is not in sync, it could be caused by one of the following:

You do not have configured sources set to On even though the source is specified in the 
configured sources list.

Your source server is IP only and your configured source is the IPXTM server name. You need 
to specify the IP address or DNS long name in the configured source list.

You have multiple NICs in the server and you are specifying an IP or NTP source. (This is a 
timing issue and doesn’t occur in all multiple-NIC environments.) 

For environments with multiple NICs (such as NetWare® routers and multiple-NIC cluster 
environments) that experience problems, insert the following at the end of your autoexec.ncf 
file:

unload timesync

load timesync
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This allows the TCP/IP stack to finish coming up and bind and initialize to all the interfaces, 
and then restarts Timesync.

Directory Tree Mode (default configuration): In order for Timesync to function in Directory 
tree mode, it uses SLP. In some mixed SLP/tree configurations, the secondary server does not 
find the Single/Reference server with the Timesync service via SLP. 

If you experience issues in your environment after having the Single/Reference and 
Secondary servers all contact the same Directory Agent, set your configured sources to On 
and contact your Single, Reference, Primary, or NTP source via the IP address or DNS long 
name.
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Debug Mode Is Now Available

Debug mode is now available on Tomcat. Enter tc4jpda at the system console to start Tomcat 
in Java Platform Debugging Architecture (JPDA) mode, which uses port 9070 for debugging. You 
can use any JPDA-enabled Java debugger to debug Tomcat operations.

Accessing Tomcat Manager

The Tomcat Manager application does not work when accessed through the port 2200 
administration page.

To resolve this issue, start a new Web browser session and go to https://domain_name:2200/
tomcat/manager/html. When prompted, enter the administrator’s eDirectoryTM username and 
password.

Tomcat Documentation

Refer to the Tomcat for NetWare Administration Guide for information about using Tomcat on 
NetWare 6.5. For the official Tomcat documentation that is created and maintained by the Apache 
Foundation’s Jakarta Project, refer to the Tomcat 4.x documentation Web page (http://
jakarta.apache.org/tomcat/tomcat-4.0-doc/index.html).
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Virtual Office Email Services

For this Beta, Virtual Office does not include Novell® GroupWise®, Microsoft* Exchange, or 
Lotus* Notes* email services. These services will be available in the NetWare® 6.5 FCS release.

Virtual Office Does Not Support SSL in this Public Beta

SSL will be supported in NetWare 6.5 FCS.
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